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TI Designs: TIDA-01255
Automotive Reinforced Isolation CAN Reference Design

Description
The TIDA-01255 design is built for isolated CAN
communication, which is widely used in automotive
environments. In hybrid and electric vehicles
(HEV/EVs), a complete high-voltage network is floating
with respect to the chassis ground. Isolation is
required for the power and communication channels
interfaced between floating high- to low-voltage
systems. The TIDA-01255 design supports
applications with a simple isolated transformer driver
to transfer power. This TI Design has a low-
transmission delay, which reduces the loop delay and
supports higher baud rates of the CAN.

Resources

TIDA-01255 Design Folder
TCAN1042-Q1 Product Folder
SN6501-Q1 Product Folder
ISO7731-Q1 Product Folder
TPS76350-Q1 Product Folder
TMS570 Product Folder

Features
• Flexible High-Speed CAN Communication
• Low Loop Delay (Typically 136 ηs) to Support High-

Speed Arbitration Rates
• 750-mW Power Transfer With 3-kV Isolation
• Reinforced Digital Isolation
• ±70-V Bus Fault Protection
• Cost-Conscious Termination With Internal ESD

Protection
• Compliant With ISO 11898-2 CAN Standard

Applications
• Cell Supervision Systems
• Battery Control Units
• Hybrid Electric Vehicles (HEV/EVs)

ASK Our E2E Experts

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUCN0
http://www.ti.com/tool/TIDA-01255
http://www.ti.com/product/TCAN1042-Q1
http://www.ti.com/product/SN6501-Q1
http://www.ti.com/product/ISO7731-Q1
http://www.ti.com/product/TPS76350-Q1
http://www.ti.com/tool/launchxl-tms57004
http://e2e.ti.com
http://e2e.ti.com/support/applications/ti_designs/
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An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other
important disclaimers and information.

1 System Description
A Controller Area Network (CAN) is widely used in automotive industry to replace the complex wiring
harness with a two-wire bus. It is highly immune to electrical interference and it has ability to self-diagnose
and repair data errors. These features have led to CAN’s popularity and extended its application in
building automation, medical, and manufacturing. The TIDA-01255 design is targeted to improve the
system and CAN performance for automotive isolated ground applications such as cell supervision units,
battery control units, inverters, chargers, and so on.

CAN manages message collision and provides a unique proving ground for protocol compliance in any
application. Any CAN node may begin to transmit when the bus is free, and two or more nodes may begin
to transmit simultaneously. Arbitration is the process by which these nodes battle for control of the bus.
Proper arbitration is critical to CAN performance because this is the mechanism that guarantees that
message collisions do not reduce bandwidth or cause messages to be lost. Each data or remote frame
begins with an identifier, which assigns the priority and content of the message. As the identifier is
broadcast, each transmitting node compares the value received on the bus to the value being broadcast.
The higher priority message during a collision has a dominant bit earlier in the identifier. Therefore, if a
transmitting node senses a dominant bit on the bus in place of the recessive bit it transmitted, it interprets
this as another message with higher priority transmitting simultaneously. This node suspends transmission
before the next bit and automatically retransmits when the bus is idle.

The evolution of automotive architectures and need for efficient power train and vehicle control
mechanisms increased the demand for the number of nodes in vehicles (both passenger and commercial).
Improvement in safety architectures increases demand for internal diagnosis and data sharing between
multiple nodes with faster response times. The number of nodes to transmit and data loads push the limits
of the CAN baud rates while staying within its advantages of reliable robust communication. CAN FD
(flexible data rate) is one such flavor of CAN communications, which gained popularity for its flexibility of
retaining the features of basic CAN (no change to physical layer) and supports high data rates with little
rise in system cost.

Loop delays and round-trip delays are limiting factors in determining arbitration and data speeds (b/s) in
classical CAN. In CAN FD, loop delay and network propagation delay are the major limiting factors during
the arbitration phase. During the data phase, a secondary sampling point plays an important role for
synchronizing data in transmitters. Transceiver delay compensation, which is nothing but a loop delay and
offset, is used to check the previously transmitted data with secondary sample registers and check for bit
errors.

Figure 1. Typical CAN Network

http://www.ti.com
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In typical ICE vehicles, loop delay and round-trip delay are straight forward to configure the transceiver
delay compensation.
• Transceiver delay compensation = Loop delay + Offset

Factors to influence loop delay in a typical CAN (non-isolated):
• Impedance of controller to transceiver interface
• Transceiver Tx-Rx delay time (dominant or recessive)
• CAN bus impedance

HEV/EV or 48-V systems are isolated from chassis ground based on system architecture. Power and
communication interfaces are isolated in high-voltage systems; ground loops are just insulated for 48-V
applications. Based on the design of control units, CAN transceivers are isolated from micro controllers as
shown in Figure 2. In this case, transceiver delay compensation is increased based on the delay in the
digital isolator.

Figure 2. Isolated HEV/EV or 48-V Systems

Factors to influence loop delay in an isolated CAN:
• Impedance of controller to digital isolator
• Propagation delay of digital isolator
• Impedance of digital isolator to CAN interface
• Transceiver Tx-Rx delay time (dominant or recessive)
• CAN bus impedance

Digital isolators play an important role in calculating loop delay. The propagation delay of digital isolators
has to account twice for the loop delay calculations in isolated CAN communication bus. Neglecting the
bus and controller impedance loop delay of isolated CAN is shown in Figure 3.

Transceiver loop delay compensation = 2 × Propagation delay of isolator + Loop delay of Tx to Rx of CAN
transceiver

In a multi-master system such as CAN, it is also important to consider the round-trip delay, which supports
in gaining the arbitration of communication bus when two nodes starts transmission at the same time. The
maximum round-trip delay or propagation delay in HEV/EV depends on the topology or mounting location
of various electronic control units in the vehicle.

http://www.ti.com
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Figure 3. Round-Trip Delay in HEV/EV

Factors to influence round-trip or propagation delay in isolated CAN:
• Impedance of controller to digital isolator
• Propagation delay of digital isolator
• Impedance of digital isolator to CAN interface
• Transceiver Tx-Rx delay time (dominant or recessive)
• CAN bus impedance
• Length of the wire

Based on the CAN physical layer, round-trip delay can be less significant. Neglecting the impedance
delays and internal software delays, the approximate round-trip delay of two isolated CAN ECUs can be
calculated as per the following equation:

Round-trip delay = 2 × (Propagation delay of digital isolator 1 + Propagation of CAN1 Tx to bus +
Propagation delay of wire + Propagation delay of CAN2 bus to Rx + Propagation delay of digital isolator 2)

1.1 Key System Specifications

Table 1. Key System Specifications

PARAMETER CONDITIONS MIN TYP MAX
TIDA-01255 loop delay CAN1 Tx to CAN1 Rx — 136 ns —
Dominant Tx to CAN bus RL = 60 Ω, CL = 4.7 ηF — 67 ns —
Recessive Tx to CAN bus 1-m wire with RL = 60 Ω, CL = 4.7 ηF — 69 ns —
Dominant CAN1 Tx to CAN2 Rx RL = 60 Ω, CL = 4.7 ηF — 115 ns —
Recessive CAN1 Tx to CAN2 Rx RL = 60 Ω, CL = 4.7ηF — 151 ns —
Rise time of CANH 1-m wire with RL = 60 Ω, CL = 4.7 ηF 30 ns 33 ns 34.31 ns
Fall time of CANH 1-m wire with RL = 60 Ω, CL = 4.7 ηF 60.4 ns 64 ns 66 ns

Operating current of TIDA-01255 CAN baud rate: 500 kbps
Isolated supply: 3.3 V — 12 mA —

Current flowing while SCB at CAN lines Battery voltage = 14 V
Tx = Low, CAN dominant state — 0.862 mA —

Current flowing while SCG at CAN lines Tx = Low, CAN dominant state — 0.189 mA —
Current flowing while SCG at CAN lines
during communication at 2 Mbps Communication is working fine — 1.29 mA —

Current flowing while CAN lines are
shorted to battery with –14 V No damages to CAN lines — 1.257 mA —

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUCN0


SN6501-Q1

TPS76350-Q 1 

Digital 
Isolator

Termination 
and Protection

CANH

CANL

GND

GNDi

CAN Tx

CAN Rx

GND

GNDi

GND i

Isolated Power

Isolated CAN Interface

TIDA-01255

3.3 V

3.3 V

3.3 V

5 V

5 V

T

T

T T

Copyright © 2017, Texas Instruments Incorporated

TCAN1042-Q1

www.ti.com System Overview

5TIDUCN0–May 2017
Submit Documentation Feedback

Copyright © 2017, Texas Instruments Incorporated

Automotive Reinforced Isolation CAN Reference Design

2 System Overview

2.1 Block Diagram

Figure 4. TIDA-01255 Block Diagram

2.2 Highlighted Products

2.2.1 TCAN1042-Q1
This CAN transceiver family meets the ISO 11898-2 (2016) High-Speed CAN physical layer standard. All
devices in the TCAN1xxx family are designed for use in CAN FD networks up to 2 Mbps. Devices with
part numbers that include the "G" suffix are designed for data rates up to 5 Mbps, and versions with the
"V" suffix have a secondary power supply input for I/O level shifting the input pin thresholds and RXD
output level. This family has a low-power standby mode with remote wake request feature. Additionally, all
devices include many protection features to enhance device and network robustness.

Key features of the TCAN1042-Q1 include:
• AEC Q100: Qualified for automotive applications
• Supports 2-Mbps CAN FD and "G" options support 5 Mbps
• Short and symmetrical propagation delay times and fast loop times for enhanced timing margin
• High impedance bus and logic terminals
• HBM ESD protection: ±16 kV
• IEC ESD protection: up to ±15 kV
• Bus fault protection: ±58 V (non-H variants) and ±70 V (H variants)
• Undervoltage protection on VCC and VIO (V variants only) supply terminals
• Typical loop delay: 110 ns

http://www.ti.com
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2.2.2 ISO7731-Q1
The ISO7731-Q1 is a high-performance, triple-channel digital isolator with 5000-VRMS (DW package) and
2500-VRMS (DBQ package) isolation ratings per UL 1577. This device has reinforced insulation ratings
according to VDE, CSA, TUV and CQC. The ISO7731-Q1 provide high electromagnetic immunity and low
emissions at low power consumption, while isolating CMOS or LVCMOS digital I/Os. Each isolation
channel has a logic input and output buffer separated by a silicon dioxide (SiO2) insulation barrier. This
device comes with enable pins that can be used to put the respective outputs in high impedance for multi-
master driving applications and to reduce power consumption. The ISO7731-Q1 device has two forward
and one reverse-direction channel. If the input power or signal is lost, the default output is high for devices
without the suffix F and low for devices with the suffix F.

Key features of the ISO7731-Q1 include:
• AEC-Q100 qualified with –40°C to 125°C ambient operating temperature
• Signaling rate up to 100 Mbps
• Wide supply and level translation from 2.25 to 5.5 V
• Low power consumption, typical 1.5 mA per channel at 1 Mbps
• Low propagation delay: 11 ns typical (5-V supplies)
• Isolation barrier life: > 40 years
• Reinforced insulation per DIN V VDE V 0884- 10 (VDE V 0884-10):2006-12
• 5000-VRMS (DW) and 2500-VRMS (DBQ) isolation rating per UL 1577
• TUV certification according to EN 60950-1 and EN 61010-1

http://www.ti.com
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2.2.3 SN6501-Q1
The SN6501-Q1 is a transformer driver designed for low-cost, small form-factor, isolated DC-DC
converters using push-pull topology. The device includes an oscillator that feeds a gate drive circuit. The
gate drive, comprising a frequency divider and a break-before-make (BBM) logic, provides two
complementary output signals that alternately turn the two output transistors on and off. The output
frequency of the oscillator is divided down by an asynchronous divider that provides two complementary
output signals with a 50% duty cycle. A subsequent BBM logic inserts a dead time between the high-
pulses of the two signals. The resulting output signals, present the gate-drive signals for the output
transistors. As shown in Figure 5, before either one of the gates can assume logic high, there must be a
short time period during which both signals are low and both transistors are high impedance. This short
period, known as BBM time, is required to avoid shorting out both ends of the primary.

Figure 5. SN6501-Q1 Block Diagram

Key features of the SN6501-Q1 include:
• AEC-Q100 qualified with –40°C to 125°C ambient operating temperature
• Push-pull driver for small transformers
• High primary-side current drive, 5-V supply: 350 mA (max)
• High primary-side current drive, 3.3-V supply: 150 mA (max)
• Single 3.3- or 5-V supply
• Low ripple on rectified output permits small output capacitors
• Device HBM ESD Classification Level H2
• Device CDM ESD Classification Level C4B
• Small 5-pin SOT-23 package

http://www.ti.com
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2.2.4 TPS67350-Q1
The TPS763xx-Q1 family of low-dropout (LDO) voltage regulators offers the benefits of LDO voltage, low-
power operation, and miniaturized packaging. These regulators feature LDO voltages and quiescent
currents compared to conventional LDO regulators. A combination of new circuit design and process
innovation has enabled the usual PNP pass transistor to be replaced by a PMOS pass element. Because
the PMOS pass element behaves as a low-value resistor, the dropout voltage is low—typically 300 mV at
150 mA of load current (TPS76333-Q1)—and is directly proportional to the load current. Because the
PMOS pass element is a voltage-driven device, the quiescent current is low (140 μA maximum) and stable
over the entire range of output load current (0 to 150 mA). Intended for use in portable systems such as
laptops and cellular phones, the LDO voltage feature and low-power operation result in a significant
increase in system battery operating life.

Figure 6. TPS76350-Q1 Block Diagram and Application Circuit

Key features of the TPS76350-Q1 include:
• AEC-Q100 qualified with –40°C to 125°C ambient operating temperature
• 150-mA LDO
• Dropout voltage, typically 300 mV at 150 mA
• Thermal protection and overcurrent limitation
• Less than 2-μA quiescent current in shutdown mode

http://www.ti.com
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3 System Design Theory
The Automotive Reinforced Isolation CAN Reference Design consists of the following subsystems:
• Isolated Power Supply
• Isolated Communication
• CAN FD Communication

3.1 Isolated Power Supply
Typical automotive batteries available in the market are 12 V, 24 V, 48 V, 100 V, 400 V, and 800 V. The
list is not limited to the voltages specified in this design guide; they are based on application power levels
of such batteries, which vary. Based on the application and design architecture, power can be derived
(buck/boost) from local batteries. In few system architectures, energy will be transferred across isolation to
support application or increase safety. Considering cost and performance, there are multiple approaches
to get the required power across isolation.

The transformer driver is the simple, cost-effective, and efficient solution for isolated power transfers
≤ 2 W. The SN6501-Q1 is an automotive low-noise transformer driver is used for this TI Design. The
SN6501-Q1 is a push-pull converter require transformers with center taps to transfer power from the
primary to the secondary.

Figure 7. SN6501-Q1 Working Principle

The SN6501-Q1 consists of an oscillator that feeds a gate drive circuit. The gate drive, comprising a
frequency divider and a break-before-make (BBM) logic, provides two complementary output signals that
alternately turn the two output transistors on and off (Q1, Q2).The output frequency of the oscillator is
divided down by an asynchronous divider that provides two complementary output signals with a 50% duty
cycle. BBM logic maintains a dead-time between the high pulses of the two signals. The resulting output
signals present the gate drive signals for the output transistors. This short period, known as BBM time, is
required to avoid shorting out both ends of the primary.
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As shown in Figure 7 when Q1 conducts, it creates a ground path for lower primary end of the center tap,
3.3 V drives a current through the lower half of the primary to ground. Current flowing in the primary
winding of transformer will create magnetic flux which will cut the secondary winding. Based on the wiring
of the transformer (shown as a dot convention), current will be flowing in the secondary coil. Dr1 is forward
biased when Q1 is closed. The secondary current flows through Dr1, charges the capacitor, LDO
(TPS76350-Q1), and returns through the load impedance back to the center tap or ground. A similar
scenario repeats when Q2 is ON, resulting current flowing in Dr2. Based on the turns ratio and frequency
of the SN6501-Q1, unregulated power is transferred across the isolation barrier.

The TPS76350-Q1 uses a PMOS pass element to reduce both dropout voltage and supply current. The
PMOS pass element is a voltage-controlled device that does not require increased drive current as output
current increases. The supply current of the TPS76350-Q1 is essentially constant from no load to
maximum load. Current limiting and thermal protection prevent damage by excessive output current or
power dissipation. The device switches into a constant-current mode at approximately 1 A; further load
reduces the output voltage instead of increasing the output current. The thermal protection shuts the
regulator off if the junction temperature rises above 165°C. Recovery of the LDO is automatic when the
junction temperature drops approximately 25°C below the high temperature trip point. The PMOS pass
element includes a back diode that safely conducts reverse current when the input voltage level drops
below the output voltage level. Thus, the isolated supply is protected and regulated to 5 V and limited to
150 mA of the load current.

3.2 Isolated Communication
Isolation is typically required to prevent DC and unwanted AC currents between two parts of a system,
while allowing signal and power transfer between those two parts. Electronic devices and semiconductor
ICs used for isolation are called isolators. In general, an isolator can be abstracted as comprising of a
high-voltage isolation component or barrier, a transmitter (TX) to couple signal into one side of the
isolation component, and a receiver (RX) to convert the signal available on the other side of the isolation
component into digital levels (see Figure 8).

Isolation became mandatory in automotive industry due to the inception of high-voltage and multiple
battery topologies. Considering the safety aspects in HEV/EV, there is a need to carry heavy payloads of
data in less time to sync the status in various high-voltage components. The ISO 7731-Q1 uses on-off
keying (OOK) based isolation communication architecture, which supports the reliable isolated data
transfer at faster rates (see Figure 9).

Figure 8. Conceptual Block Diagram

http://www.ti.com
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Figure 9. OOK Mechanism in ISO 7731-Q1

As per OOK architecture, incoming digital bitstream is modulated with an internal spread spectrum
oscillator clock to generate OOK signaling, such that one of the input states is represented by
transmission of a carrier frequency, and the other state by no transmission. This modulated signal is
coupled to the isolation barrier and appears in an attenuated form on the receive side. The receive path
consists of a pre-amplifier to gain up the incoming signal followed by an envelope detector that serves as
a demodulator to regenerate the original digital pattern. The TX and RX signal conditioning circuits are
used to improve the common-mode rejection of the channel resulting in better common-mode transient
immunity (CMTI). Spread spectrum feature of the architecture will support emissions reduction. ISO 7731-
Q1 with a wide body package can with stand 5000 VRMS or 3600 VPEAK.

A typical propagation delay of 11 ηs supports the safety and achieve high data rates up to 100 Mbps.

3.3 CAN FD Communication
CAN controllers play a significant role in configuring the CAN communication bus. Based on in-vehicle
network topologies, there can be multiple CAN communication buses in a car. They can be classified
based on various parameters such as function of electronic control units (body, powertrain, infotainment,
ADAS, and so on), type of CAN, baud rates, and ground loops. Typically, CAN 2.0 can support data rates
up to 500 kbps, CAN FD architectures can support data rates up to 5 Mbps and greater. While retaining
core features of CAN, CAN FD comes up with greater benefits in data baud rates with a short rise in
complexity and cost.

CAN FD had an impact on the microcontroller, crystal, and transceiver and little extent on the wiring
harness (to support the EMC for high dates). The physical layer of CAN controllers needs to support the
change in baud rates. Due to increased data rates, an appropriate crystal needs to be selected to support
the CAN timings and error handling. CAN transceiver selection plays an important role for the EMC on
CAN bus and delay calculations in CAN timing.
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Figure 10. TCAN1042-Q1 CAN Transceiver

The TCAN1042-Q1 CAN transceiver meets the ISO 11898-2 (2016) High-Speed CAN physical layer
standard (see Figure 10). It is designed to support the high data rates up to 5 Mbps (G-version). The
device has options to be compatible with 3.3- and 5-V TTL input by selecting the VIO pin voltage
appropriately. The dominant time out feature enables the CAN communication bus to be error free due to
error in the microcontroller. If a dominant bit is being transmitted by the microcontroller, due to internal
software or hardware issues, the controller does not respond any more, and the CAN transceiver will free
up the communication bus after the dominant time out delay (minimum 1.2 ms or max 3.8 ms). The wake
up monitor circuit allows low-power modes to the CAN transceiver and electronic control units. This
feature saves the need for an external wake up pin and wire and allows the system to stay in standby
mode. With an appropriate wake up pattern, electronic control units can be retrieved to a run state from
sleep or standby states.

Thermal shutdown and short circuit current limit features in the TCAN1042-Q1 improves the reliability and
robustness of CAN communication. During thermal shutdown, the device turns off the CAN driver circuits,
thus blocking the TXD-to-bus transmission path, so CANH and CANL are biased to the recessive level
during a thermal shutdown and the receiver-to-RXD path remains operational. CAN bus driver pins are
protected by a short-circuit limit feature irrespective of the state of the input (dominant or recessive).

Transceiver delay plays an important role for the bit timing calculations in CAN FD. The total loop delay of
the transceiver is typically 110 ns and worst case 175 ns, which is good enough to support high data
rates.
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4 Getting Started Hardware and Software

4.1 Hardware

Figure 11. TIDA-01255 Schematic

The SN6501-Q1 can be used to generate the isolated power less than 1 W. This can be used to generate
the bias power, sensors, or light isolated loads (to power few IC's).
• Input power: 3.3 V, 150 mA
• Output power: 5 V, 100 mA

Detailed steps for designing the SN6501-Q1 are provided in the device datasheet. T1 is selected with a
1:2 ratio, which gives max regulated voltage from 6 to 7 V on the secondary side (pins 6,4 of T1). After the
diode drop (D1,D2), the voltage at input of the TPS76350-Q1 will be around 6.5 V. The regulated output
voltage of 5 V is generated from U4 of the TPS76350-Q1.
• C1,C2 are the filter capacitors, which are placed near the VCC pin of U1 of the SN6501-Q1.
• T1 is a center tapped transformer connected U1 is selected based on input and output voltage. A

475-μH SMT transformer from 760390015 has been used for T1.
• D1 and D2 are Schottky diodes that are used for low forward voltage drop and rectify the output

voltage.
• U4 of the TPS76350-Q1 is used to regulate the output voltage from the transformer driver, whereas

C9,C10, C11, and C12 should be placed close to the U4 and are used to filter the output voltage.
• C6, C7 are the decoupling capacitors used for ISO 7731-Q1. C3, C4, and C5 are ESD capacitors used

only on this board, based on ECU's layout these capacitors can be placed or neglected.
• U2 of ISO 7731-Q1 supports reinforced signal isolation for transferring CAN Tx, CAN Rx, and standby

pins from controller to U3 (TCAN1042-Q1).

Either the common-mode choke L1 or bypass resistors R2,R3 are populated on the PCB. The common-
mode choke is placed on the PCB based on EMC requirements of the ECU. R4, R5 and C13 is the
popular split resistor termination used for CAN communication. C14 and C15 are the nominal ESD
capacitors to be placed near the connector.
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Table 2 lists the important parameters for designing the isolated CAN interface with the TIDA-01255
design.

Table 2. Isolated CAN Calculations

PARAMETER MIN (ηs) TYP (ηs) MAX (ηs)
Propagation delay of isolator (ISO7731-Q1) 6.0 11 16.0
Transceiver propagation delay time of TCAN1042-Q1 (RL = 60 Ω, CL = 100 pF) — 110 175.0
Propagation delay of Tx to CAN bus — 55 75.0
Propagation delay of CAN bus to Rx — 50 65.0
Propagation delay of physical 1-m copper wire (estimation) 4.8 5 5.3
Approximate loop delay CAN message with TIDA-01225 — 132 208.0
Approximate round trip delay of CAN message with two TIDA-01255 boards
located 30 m apart — 454 556.0

4.2 Software
Software for the CAN is developed and generated based on customer requirements and the
microcontroller of the ECU. The CAN calculation table can be used for internal baud rate calculations.
TIDA-01255 hardware can be tested directly interfacing with the microcontroller of the ECU. The TIDA-
01255 can be tested directly by interfacing with TMS570 LaunchPad™ devices.

Hardware Abstraction Layer Code Generator (HALCoGen) and Code Composer Studio™ (CCS) can be
used to generate the software to test the CAN interface. Follow the instructions provided in Hercules™
LaunchPad.
1. Download and Install HALCoGen, Code Composer Studio.
2. Open the HALCoGen SW→ File → New → Project.
3. Select the microcontroller family for the LaunchPad. Select the appropriate device. Give the user

defined project name and select a location to save the project.

Figure 12. HALCoGen Project Creation
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4. Select the driver enable, and unmark all drivers. Based on the scope of the project, select the
appropriate drivers such as CAN, GIO, SCI, ADC, and so on.

Figure 13. HALCoGen Enable Driver
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5. Edit the settings for the drivers such as SCI, CAN1, and CAN2. Update the bit rate as per the design,
check the propagation delay for the given baud rate, and complete the system settings.

Figure 14. HALCoGen CAN Configuration

6. Generate the code in HALCoGen by pressing F5.
7. Open CCS. Press File → New → Project → CCS project under Code Composer Studio.
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8. Select the target and device as per the family of LaunchPad. Select the connection type as per the
LaunchPad interface to PC. Provide the same project name and location that was given in HALCoGen.
Select the empty project without any main.c and press Finish to create the CCS project.

Figure 15. CCS Project Creation

http://www.ti.com
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9. Include the files created in HALCoGen, right click on the Project → Properties → Build → ARM
compiler → Include options → Add the path of include folder generated from HALCoGen.

Figure 16. CCS Include Files

10. Start writing the user code section in the sys_main.c file. Build and load the code in CCS to the target
LaunchPad and test the CAN communication.

http://www.ti.com
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5 Testing and Results

Figure 17. Test Setup for TIDA-01255

The TIDA-01255 design was tested using the TMS570LS04x LaunchPad. Two TIDA-01255 boards are
connected as shown in Figure 17.
• Software is built in CCS in such a way that data is sent from "CAN1", which is acknowledged by

"CAN2" of the same LaunchPad. A laptop is used to monitor the registers and communication of
LaunchPad.

• Baud rate of CAN communication is set in HALCoGen. The latest files are built and loaded into launch
to check the performance of the TIDA-01255.

• Twisted pair wiring harness with different lengths is used to connect the CANH and CANL.
• Tests are performed for different configurations of wire lengths and baud rates.
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5.1 Operational Tests

Figure 18. SN6501-Q1 Primary Side

CH1: VCC3.3V
CH2: D2 pin of SN6501-Q1 primary
CH3: D1 pin of SN6501-Q1 primary

NOTE: Isolated power primary side

Max of D1,D2 = 7.5 V
Min of D1,D2 = 0.769 V
Frequency of D2 = 362 kHz
Frequency of D1 = 363 kHz

Figure 19. SN6501-Q1 Secondary Side

.
CH1: VCC3.3V
CH2: Anode pin of D1, secondary side
CH3: Anode pin of D2, secondary side

NOTE: Isolated power secondary side

Max of D1,D2 = 7.5 V
Min of D1,D2 = 0.769 V
Frequency of D2 = 362 kHz
Frequency of D1 = 362 kHz
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Figure 20. SN6501-Q1 Secondary Side
(Rise and Fall Times)

.
CH1: VCC3.3V
CH2: Anode pin of D1, secondary side
CH3: Anode pin of D2, secondary side

NOTE: Isolated power secondary side

Max of D1,D2 = 7.5 V
Min of D1,D2 = 0.769 V
Frequency of D2 = 362 kHz
Rise time of D1,D2 = 187 ns
Fall time of D1,D2 = 184 ns

Figure 21. CAN Message With Common Ground

.
CH1: CAN high
CH2: CAN low

NOTE: CAN message with 1-m wire,
ground wire along with CANH
and CANL

Recessive of CANH and CANL = 2.5 V
Dominant of CANH = 3.72 V (Max)
Dominant of CANL = 1.26 V (Min)
Rise time of CANH = 34.31 ns
Fall time of CANH = 63.20 ns
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Figure 22. CAN Message Without Common
Ground

.
CH1: CAN high
CH2: CAN low

NOTE: CAN message with 1-m wire, no
ground wire; only CANH and
CANL are connected

Recessive of CANH and CANL = 2.5 V
Dominant of CANH = 3.89 V (max)
Dominant of CANL = 1.174 V (min)
Rise time of CANH = 40 ns

Figure 23. CAN Message Without Common
Ground (CAN1 ACK)

.
CH1: CAN1 Tx
CH2: CAN1 Rx
CH3: CAN2 Tx
CH4: CAN2 Rx

NOTE: CAN message with 1-m wire,
messages from CAN2 and ACK
from CAN1
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5.2 Performance Tests

Figure 24. TIDA-01255 Tx to CAN
(Recessive to Dominant)

.
CH1: CAN high
CH2: CAN low
CH3: CAN Tx

NOTE: CAN message with 1-m wire,
TIDA-01255 propagation delay
(recessive to dominant)

Dominant: Delay of Tx to CAN = 67 ns

Figure 25. TIDA-01255 Tx to CAN
(Dominant to Recessive)

.
CH1: CAN high
CH2: CAN low
CH3: CAN Tx

NOTE: CAN message with 1-m wire,
TIDA-01255 propagation delay
(dominant to recessive)

Recessive: Delay of Tx to CAN = 69 ns
(approximately)
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Figure 26. TIDA-01255 Loop Delay

.
CH1: CAN1 Tx
CH2: CAN1 Rx
CH3: CAN2 Tx
CH4: CAN2 Rx

NOTE: CAN message with 1-m wire,
loop delay of TIDA-01255 CAN1
Tx to Rx

Loop delay of TIDA-01255 = 136 ns
(approximately)

Figure 27. TIDA-01255 Half Round-Trip Delay
(Recessive)

.
CH1: CAN1 Tx
CH2: CAN1 Rx
CH3: CAN2 Tx
CH4: CAN2 Rx

NOTE: CAN message with 1-m wire,
transmission delay from one
TIDA-01255 to another (half of
round trip delay with 1-m wire)

Recessive: Delay of CAN1 Tx to CAN2 Rx = 151 ns
(approximately)
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Figure 28. TIDA-01255 Half Round-Trip Delay
(Dominant)

.
CH1: CAN1 Tx
CH2: CAN1 Rx
CH3: CAN2 Tx
CH4: CAN2 Rx

NOTE: CAN message with 1-m wire,
transmission delay from one
TIDA-01255 to another (half of
round trip delay with 1-m wire)

Dominant: Delay of CAN1 Tx to CAN2 Rx = 115 ns
(approximately)

Figure 29. TIDA-01255 500 kbps (Single Bit)

.
CH1: CANH
CH2: CANL

NOTE: 500-kbps CAN message, 1-m
twisted pair wiring harness

Dominant: Delay of CAN1 Tx to CAN2 Rx = 115 ns
(approximately)
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Figure 30. TIDA-01255 500 kbps (Multiple Bits)

.
CH1: CANH
CH2: CANL

NOTE: 500-kbps CAN message, 1-m
twisted pair wiring harness

Recessive of CANH and CANL = 2.5 V
Dominant of CANH = 3.73 V (max)
Dominant of CANL = 1.26 V (min)
Rise time of CANH = 33.98 ns
Fall time of CANH = 66.34 ns

Figure 31. TIDA-01255 1 Mbps

.
CH1: CANH
CH2: CANL

NOTE: 1-Mbps CAN message, 1-m
twisted pair wiring harness

Recessive of CANH and CANL = 2.5 V
Dominant of CANH = 3.72 V (Max)
Dominant of CANL = 1.26 V (Min)
Rise time of CANH = 34.31 ns
Fall time of CANH = 63.20 ns
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Figure 32. TIDA-01255 2 Mbps (Single Bit)

.
CH1: CANH
CH2: CANL

NOTE: 500-kbps CAN message, 1-m
twisted pair wiring harness

Recessive of CANH and CANL = 2.5 V
Dominant of CANH = 3.72 V (Max)
Dominant of CANL = 1.29 V (Min)
Rise time of CANH = 30.43 ns
Fall time of CANH = 61.88 ns

Figure 33. TIDA-01255 2 Mbps (Multiple Bits)

.
CH1: CANH
CH2: CANL

NOTE: 2-Mbps CAN message, 1-m
twisted pair wiring harness

Recessive of CANH and CANL = 2.5 V
Dominant of CANH = 3.72 V (max)
Dominant of CANL = 1.28 V (min)
Rise time of CANH = 33 ns
Fall time of CANH = 60.41 ns

5.3 Reliability Tests
CAN is used as reliable communication in automotive environments. ECUs should have a robust hardware
to support the reliable communication protocol. The TIDA-01255 has been tested for typical automotive
noises on the CAN communication.

5.3.1 Transient Immunity Capacitor Coupling
The purpose of this test is to ensure that the TIDA-01255 will not be damaged as a result of excessive
transients that may occur as a result of unique inductive wiring harness crosstalk. Tests have been
performed as per ISO 7637-3 for slow transient pulses. The test setup with the TIDA-01255 has been built
as shown in Figure 34.
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Figure 34. Capacitive Coupling Test Setup

NOTE: Harness length = 1.7 m

An oscilloscope is used to monitor CAN1 Tx and CAN1 Rx. The laptop is used to control and monitor the
TMS570 LaunchPad to get the status of the CAN. The setup box is used to couple the transient with a
100-nF capacitance from the transient generator to the CAN wiring harness. As two TIDA-01255 boards
are connected back to back, DCC tests are performed only once for each test leg.

Table 3. Transient Immunity Test Results

TEST CASE VOLTAGE LEVEL
(V)

TEST DURATION
(MIN) OBSERVATION

DCC Slow – –45 5 TIDA-01255 works fine. No impact on CAN communication.
Performance A

DCC Slow + 45 5 TIDA-01255 works fine. No impact on CAN communication.
Performance A

DCC Slow – –85 1 TIDA-01255 works fine. No impact on CAN communication.
Performance A

DCC Slow + 85 1 TIDA-01255 works fine. No impact on CAN communication.
Performance A
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5.3.2 RF Immunity: Bulk Current Injection
RF immunity of ECUs are done with the proper application software based on the type of systems (engine
EMS, vehicle control unit, body control, transmission control, battery control, DC-DC, inverter, OBC, and
so on). Critical parameters of the system are monitored and measured during the RF immunity tests.
Communication of safety critical nets is important, which is not expected to disturb while performing these
tests. Based on the type of end system, performance and pass criteria is defined for the bulk current
immunity tests. The TIDA-01255 is tested with just an CAN application layer software, which does not
include supervisor or watchdog systems. Performance of the TIDA-01255 and TCAN1042-Q1 can be
different when used with an end application software.

Bulk current injection (BCI) tests are performed in an external test house as per ISO 11452-4.

Figure 35. BCI Setup and Injector Probe at 15 cm

Figure 36. BCI Test Setup for Injector Probes at 45 and 75 cm

Table 4. BCI Test Parameters

PARAMETER DESCRIPTION
Frequency modulation Continuous Wave AM (1 kHz, 80 %)

Frequency steps 300 kHz for 0.1 to 1 MHz 1 MHz for 1 to 200 MHz 2 MHz for 200 to 400 MHz
Dwell time 2 sec

Distance of EuT – Clamp 15 cm 45 cm 75 cm
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Table 5. BCI Test Plan

TEST LEVEL FREQUENCY RANGE
(MHz)

CATEGORY 1
dB(µA)

CATEGORY 2
dB(µA)

CATEGORY 3
dB(µA)

Level 2

0.1 to 2.38 90 90

Not specified
2.38 to 15 106-20 log(15/f) 106-20 log(15/f)
15 to 88 106 106
88 to 400 106-10 log(f/88) 106-10 log(f/88)

Level 1

0.1 to 2.38 82 90 90
2.38 to 15 98-20 log(15/f) 102-20 log(15/f) 106-20 log(15/f)
15 to 88 98 102 106
88 to 400 98-10 log(f/88) 102-10 log(f/88) 106-10 log(f/88)

BCI tests results for the TIDA-01255 with a 500-kbps CAN baud rate are as follows:
• Category 2 Level 1 for 15 cm, no damage to components. The TIDA-01255 is working fine upon reset.

Performance C is achieved.
• Category 3 Level 1 for 15 cm, no damage to components. The TIDA-01255 is working fine upon reset.

Performance C is achieved.
• Category 2 Level 1 for 45 cm, no damage to components. The TIDA-01255 is working fine upon reset.

Performance C is achieved.
• Category 2 Level 1 for 75 cm, no damage to components. The TIDA-01255 is working fine upon reset.

Performance C is achieved.

Tests are done on the LaunchPad with basic software without any supervisor or watchdog system.
Performance of the TCAN1042-Q1 and system can be improved by using software built for relevant
control units.

5.3.3 RF Emissions
RF emission tests are done on the TIDA-01255 in an anechoic chamber at the EMC test house. The
LaunchPad is flashed with different software that enable CAN communication at different baud rates. More
details are available upon request.
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5.3.4 ESD
Testing has been performed in accordance with ISO 10605. Tests are carried out in a shielded chamber.
Test setup is done as per Figure 37.

Figure 37. ESD Test Setup

ESD tests are performed with two TIDA-01255 boards connected back to back as shown in Figure 37.
Wire length is 1.7 m.

Table 6. ESD Test Results

DISCHARGE SEQUENCE TYPE OF DISCHARGE VOLTAGE LEVEL (kV) RESULT
1

Contact discharge C = 330 pF, R = 2 kΩ
4 Performance A

2 –4 Performance A
3

Air discharge C = 330 pF, R = 2 kΩ
4 Performance A

4 –4 Performance A
5

Contact discharge C = 330 pF, R = 2 kΩ
8 Performance A

6 –8 Performance A
7

Air discharge C = 330 pF, R = 2 kΩ
8 Performance A

8 –8 Performance A
9

Air discharge C = 330 pF, R = 2 kΩ
15 Performance A

10 –15 Performance A

No disturbance happened to CAN communication. CAN waveforms are monitored in the oscilloscope
while ESD tests are being performed. Both TIDA-01255 boards were working fine after completing all
ESD tests.
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6 Design Files

6.1 Schematics
To download the schematics, see the design files at TIDA-01255.

6.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-01255.

6.3 PCB Layout Recommendations
For the optimal performance of the system, follow best practices of designing the PCB. Isolated power and
CAN lines are critical, which affect the performance of the system.
• Place U1 SN6501-Q1 near to the transformer T1. Take care to have short traces and symmetry from

D1, D2 to T1.

Figure 38. Isolated Power Supply

• As shown in Figure 38, Schottky diodes D1 and D2 are in symmetry and to be placed with less track
length to avoid high trace inductances.

• Based on the number of layers of the PCB, there should be vias or short resistance path to isolated
ground to the ground pins of the center tapped transformer and LDO.

• Creepage distance of the isolated sections should be defined based on the customer requirements.
Based on the type of material, creepage distance will vary on the PCB. For more details of layout
recommendations, see the Digital Isolator Design Guide (SLLA284).
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Figure 39. Isolated Section

• To avoid any interference with the signal lines, it is good to shield the outer layers of the isolated
section as shown in Figure 39.

• Layout of the CAN signals has to be done carefully to avoid any impedance mismatch for the CAN
high and CAN low lines. Symmetry and shielding of the CAN signals from the controller, digital isolator,
and transceiver are important.
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Figure 40. TCAN1042-Q1 Interface Circuit

• CAN termination layout is critical for the operation of CAN communication. Placement of CAN
termination resistors R4 and R5 along with common-mode capacitor C13 play an important role for the
low-pass filter of CAN messages.

• Place the ESD capacitor or special ESD suppression diodes close to the connector pins.

6.3.1 Layout Prints
To download the layer plots, see the design files at TIDA-01255.

6.4 Altium Project
To download the Altium project files, see the design files at TIDA-01255.

6.5 Gerber Files
To download the Gerber files, see the design files at TIDA-01255.

6.6 Assembly Drawings
To download the assembly drawings, see the design files at TIDA-01255.
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7 Software Files
To download the software files, see the design files at TIDA-01255.

8 Related Documentation

1. Texas Instruments, Controller Area Network Physical Layer Requirements , Application Report
(SLLA270)

2. Texas Instruments, Common Mode Chokes in CAN Networks: Source of Unexpected Transients ,
Application Report (SLLA271)

3. Texas Instruments, SN6501 Multi-Transformer EVM User's Guide (SLLU174)
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